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This process License Agreement (”PLA”) is a legal agreement between you and Sawgrass Technologies, Inc. (”Sawgrass”). 
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END-USER LICENSE AGREEMENT FOR SAWGRASS SOFTWARE
—DualJet 4880 Driver™
IMPORTANT-READ CAREFULLY: This Sawgrass Technologies Inc. End-User License 
Agreement (“EULA”) is a legal agreement between you (either an individual or a single 
entity) and Sawgrass Technologies, Inc for the Sawgrass Software Product identified 
above, which includes computer software and may include associated media, printed 
materials, and “online” or electronic documentation (“SOFTWARE PRODUCT”). By 
installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree to be bound 
by the terms of this EULA. If you do not agree to the terms of this EULA, do not install or 
use the SOFTWARE PRODUCT.
Software PRODUCT LICENSE
Copyright laws and international copyright treaties, as well as other intellectual property 
laws and treaties protect the SOFTWARE PRODUCT. The SOFTWARE PRODUCT is 
licensed, not sold.  The title to, and ownership of, this SOFTWARE PRODUCT remains 
with Sawgrass Technologies, Inc. (Sawgrass).
GRANT OF LICENSE. This EULA grants you the following rights:
	 •	 This license is provided to you for your use according to the terms hereof. You
		  may install and use the SOFTWARE PRODUCT packaged herewith to practice
		  the printing process described in U.S. Patent No.  5,488,907 (the “Sawgrass
		  Process”).  The use of any ink, dye or pigment to practice the 	 Sawgrass
		  Process, other than an ArTainium/ChromaBlast ink which is purchased from
		  Sawgrass or its authorized distributor, is not a licensed use of the SOFTWARE
		  PRODUCT. You agree not to use the SOFTWARE PRODUCT for any other
		  purpose or in any process except as expressly permitted hereby. 
	 •	 Not for Resale. You may not sell, or otherwise transfer for value, the SOFTWARE
		  PRODUCT.
	 •	 No Reverse Engineering, Decompilation, Copying or Disassembly. You may not
		  reverse engineer, decompile, copy or disassemble the SOFTWARE PRODUCT.	
	 •	 No Rental. You may not rent, lease, or lend the SOFTWARE PRODUCT. 
	 •	 Support Services. Sawgrass Technologies, Inc. may provide you with 		
		  support services related to the SOFTWARE PRODUCT (“Support Services”). 	
		  Use of Support Services is governed by the Sawgrass policies and programs 	
		  described in the user manual, in “online” documentation, and/or in other 		
		  Sawgrass-provided materials. Any supplemental software code provided to
		  you as part of the Support Services shall be considered part of the SOFTWARE
		  PRODUCT and subject to the terms and conditions of this EULA. With respect
		  to technical information you provide to Sawgrass as part of the Support
		  Services, Sawgrass may use such information for its business purposes,
		  including for product support and development. Sawgrass will not utilize such
		  technical information in a form that personally identifies you.
	 •	 No Assignment or Sublicense.  You may not assign or sublicense the rights 	
		  granted hereby.  
	 •	 Termination. Without prejudice to any other rights, Sawgrass may terminate 	
		  this EULA if you fail to comply with the terms and conditions of this EULA. In
		  the event of termination, you must destroy all copies of the SOFTWARE 		
		  PRODUCT and all of its component parts.
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COPYRIGHT.  All title and copyrights in and to the SOFTWARE PRODUCT (including 
but not limited to any images, photographs, animations, video, audio, music, text, and 
“applets” incorporated into the SOFTWARE PRODUCT), the accompanying printed 
materials, and any copies of the SOFTWARE PRODUCT are owned by Sawgrass 
Technologies Inc. or its suppliers.  Copyright laws and international treaty provisions 
protect the SOFTWARE PRODUCT.  Therefore, you must treat the SOFTWARE PRODUCT 
like any other copyrighted material, except that you may install the SOFTWARE PRODUCT 
on a computer for the uses permitted hereby. You may not copy the printed materials 
accompanying the SOFTWARE PRODUCT.   You may not loan, rent, lease, or otherwise 
transfer the other medium to another user, except as part of the permanent transfer (as 
provided above) of the SOFTWARE PRODUCT.

U.S. GOVERNMENT RESTRICTED RIGHTS. The SOFTWARE PRODUCT and 
documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure 
by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of 
the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or 
subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights 
at 48 CFR 52.227-19, as applicable.

MISCELLANEOUS

	 a.	 If you acquired this product in the United States, this EULA is governed by 	
		  the laws of the State of South Carolina.  In the event of any dispute arising
		  under this license or from the use of the SOFTWARE PRODUCT, each party 	
		  irrevocably agrees to the jurisdiction of the United States District Court for 	
		  the District of South Carolina, Charleston Division.
 
	 b.	 If you acquired this product in Canada, this EULA is governed by the laws of
		  the Province of Ontario, Canada. In the event of any dispute arising 		
		  under this license or from the use of the SOFTWARE PRODUCT, each party 	
		  irrevocably agrees to the jurisdiction of the courts of the Province of Ontario 	
		  and further agrees to commence any litigation which may arise hereunder in 	
		  the courts located in the Judicial District of York, Province of Ontario. 

	 c.	 If this product was acquired outside the United States, then local law may 	
		  apply.

LIMITED WARRANTY. Sawgrass warrants that (a) the SOFTWARE PRODUCT will 
perform substantially in accordance with the accompanying written materials for a period 
of thirty (30) days from the date of receipt, and (b) any Support Services provided by 
Sawgrass shall be substantially as described in applicable written materials provided to 
you by Sawgrass, and Sawgrass support engineers will make commercially reasonable 
efforts to solve any problem issues. Some states and jurisdictions do not allow limitations 
on duration of an implied warranty, so the above limitation may not apply to you. To the 
extent allowed by applicable law, implied warranties on the SOFTWARE PRODUCT, if 
any, are limited to thirty (30) days.
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CUSTOMER REMEDIES. Sawgrass’ and its suppliers’ entire liability and your exclusive 
remedy shall be, at Sawgrass’ option, either (a) return of the price paid, if any, or (b) 
repair or replacement of the SOFTWARE PRODUCT that does not meet Sawgrass’ 
Limited Warranty and which is returned to Sawgrass with a copy of your receipt. This 
Limited Warranty is void if failure of the SOFTWARE PRODUCT has resulted from 
accident, abuse, or misapplication. Any replacement SOFTWARE PRODUCT will be 
warranted for the remainder of the original warranty period or thirty (30) days, whichever 
is longer. Outside the United States, neither these remedies nor any product support 
services offered by Sawgrass are available without proof of purchase from an authorized 
international source.

NO OTHER WARRANTIES. To the maximum extent permitted by applicable law, 
Sawgrass and its suppliers disclaim all other warranties and conditions, either express 
or implied, including, but not limited to, implied warranties of merchantability, fitness 
for a particular purpose, title, and non-infringement, with regard to the SOFTWARE 
PRODUCT, and the provision of or failure to provide Support Services.  This limited 
warranty gives you specific legal rights. You may have others, which vary from state/
jurisdiction to state/jurisdiction.

LIMITATION OF LIABILITY. To the maximum extent permitted by applicable law, in no 
event shall Sawgrass or its suppliers be liable for any special, incidental, indirect, or 
consequential damages whatsoever (including, without limitation, damages for loss 
of business profits, business interruption, loss of business information, or any other 
pecuniary loss) arising out of the use of or inability to use the SOFTWARE PRODUCT 
or the provision of or failure to provide Support Services, even if Sawgrass has been 
advised of the possibility of such damages. In any case, Sawgrass’ entire liability under 
any provision of this EULA shall be limited to U.S. $5.00. Because some states and 
jurisdictions do not allow the exclusion or limitation of liability, the above limitation may 
not apply to you.

ArTainium®, is a Registered Trademark, and DualJet™, ChromaBlast™ and ColorSure™ 
are Trademarks of Sawgrass Technologies, Inc.)

General Notice: Other product names used herein are for identification purposes only 
and may be trademarks of their respective owners.  Sawgrass Technologies, Inc. 
disclaims any and all rights in those marks.
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IMPORTANT – READ CAREFULLY:
This product is for commercial use only. 

This Process License Agreement (“PLA”) is a legal agreement between you and Sawgrass 
Technologies, Inc. (“Sawgrass”). By installing the ArTainium®/ChromaBlast™ cartridge 
in your printer, or otherwise using the Sawgrass ArTainium®/ChromaBlast™ ink, you 
agree to be bound by the terms of this PLA. If you do not agree to the terms of this PLA, 
Sawgrass is unwilling to license the process of using the ArTainium®/ChromaBlast™ 
ink to you. In such event, you may not use the ArTainium®/ChromaBlast™ ink, and 
you should promptly contact your supplier for instructions on return of the unopened 
package.

The process of using ArTainium®/ChromaBlast™ ink is protected by U.S. and foreign 
patents. Sawgrass will provide a complete list of the relevant patents upon request. The 
use of the ArTainium®/ChromaBlast™ ink to practice the patented process is permitted 
by this license.

1.	 GRANT OF LICENSE.
	 This PLA grants you the following rights: 
	 You may install and use the ArTainium®/ChromaBlast™ ink packaged herewith 	
	 in your EPSON printer to practice the printing process described in U.S. Patent 	
	 No. 6,341,856 (“Sawgrass Process”).  The use of any ink, dye or pigment to 	
	 practice the Sawgrass Process, other than a ArTainium®/ChromaBlast™ ink 	
	 purchased from Sawgrass or its authorized distributor accompanied by a PLA, is
	 not 	a licensed use of the Sawgrass Process. No rights to use the Sawgrass 	
	 Process, except those specified herein, are granted, and no rights to use any other 	
	 process, product, software or hardware developed or sold by Sawgrass are 		
	 granted or implied hereby.

2.	 LIMITATIONS ON REVERSE ENGINEERING 
	 You agree that you will not attempt to reverse engineer, reproduce or deformulate 	
	 the ArTainium®/ChromaBlast™ ink.

3.	 PATENTS AND COPYRIGHTS 
	 Sawgrass owns multiple U.S. and foreign patents which may apply to the
	 Sawgrass Process and/or the use of ArTainium®/ChromaBlast™ ink. All
	 patents in and to the method of using ArTainium®/ChromaBlast™ ink are owned
	 by Sawgrass Technologies, Inc. You may not copy the printed materials 		
	 accompanying the ArTainium®/ChromaBlast™ ink. All rights not specifically 	
	 granted under this PLA are reserved by Sawgrass Technologies, Inc.

Sawgrass agrees to replace any defective product, or to refund the purchase price, within 
a reasonable time, which shall be Sawgrass’ sole responsibility for errors or defects in the 
goods.  THERE ARE NO OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO, ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE. SAWGRASS SHALL NOT BE LIABLE FOR LOSS OF 
PROFIT OR OTHER ECONOMIC LOSS, OR FOR INDIRECT, SPECIAL, CONSEQUENTIAL 
OR OTHER SIMILAR DAMAGES.
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END-USER LICENSE AGREEMENT FOR SAWGRASS 
SOFTWARE—ChromaBlast Driver™ 
IMPORTANT-READ CAREFULLY: This Sawgrass Technologies Inc. End-User License 
Agreement (“EULA”) is a legal agreement between you (either an individual or a single 
entity) and Sawgrass Technologies, Inc. for the Sawgrass software product identified 
above, which includes computer software and may include associated media, printed 
materials, and “online” or electronic documentation (“SOFTWARE PRODUCT”). By 
installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree to be bound 
by the terms of this EULA. If you do not agree to the terms of this EULA, do not install or 
use the SOFTWARE PRODUCT.

Software PRODUCT LICENSE
Copyright laws and international copyright treaties, as well as other intellectual property 
laws and treaties protect the SOFTWARE PRODUCT. The SOFTWARE PRODUCT is 
licensed, not sold.  The title to, and ownership of, this SOFTWARE PRODUCT remains 
with Sawgrass Technologies, Inc. (Sawgrass).

GRANT OF LICENSE. This EULA grants you the following rights:

	 •	 This license is provided to you for your use according to the terms hereof.  	
		  You may install and use the SOFTWARE PRODUCT packaged herewith to 	
		  practice the printing process described in U.S. Patent No.  6,341,856 (the 	
		  “Sawgrass Process”).  The use of any ink, dye or pigment to practice the 	
		  Sawgrass Process, other than a ArTainium®/ChromaBlast™ ink which is 	
		  purchased from Sawgrass or its authorized distributor, is not a licensed use 	
		  of the SOFTWARE PRODUCT. You agree not to use the SOFTWARE PRODUCT 	
		  for any other purpose or in any process except as expressly permitted hereby. 

	 •	 Not for Resale. You may not sell, or otherwise transfer for value, the 		
		  SOFTWARE PRODUCT.

	 •	 No Reverse Engineering, Decompilation, Copying or Disassembly. You may
		  not reverse engineer, decompile, copy or disassemble the SOFTWARE 		
		  PRODUCT.	
	 •	 No Rental. You may not rent, lease, or lend the SOFTWARE PRODUCT. 

	 •	 Support Services. Sawgrass Technologies, Inc. may provide you with 		
		  support services related to the SOFTWARE PRODUCT (“Support Services”). 	
		  Use of Support Services is governed by the Sawgrass policies and programs 	
		  described in the user manual, in “online” documentation, and/or in other 	
		  Sawgrass-provided materials. Any supplemental software code provided 	
		  to you as part of the Support Services shall be considered part of the 		
		  SOFTWARE PRODUCT and subject to the terms and conditions of this EULA. 	
		  With respect to technical information you provide to Sawgrass as part of 	
		  the Support Services, Sawgrass may use such information for its business 	
		  purposes, including for product support and development. Sawgrass will not 	
		  utilize such technical information in a form that personally identifies you.
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	 •	 No Assignment or Sublicense.  You may not assign or sublicense the rights 	
		  granted 	hereby.  

	 •	 Termination. Without prejudice to any other rights, Sawgrass may terminate 	
		  this EULA if you fail to comply with the terms and conditions of this EULA. 	
		  In the event of termination, you must destroy all copies of the SOFTWARE 	
		  PRODUCT and all of its component parts.

COPYRIGHT.  All title and copyrights in and to the SOFTWARE PRODUCT (including 
but not limited to any images, photographs, animations, video, audio, music, text, and 
“applets” incorporated into the SOFTWARE PRODUCT), the accompanying printed 
materials, and any copies of the SOFTWARE PRODUCT are owned by Sawgrass 
Technologies Inc. or its suppliers.  Copyright laws and international treaty provisions 
protect the SOFTWARE PRODUCT.  Therefore, you must treat the SOFTWARE PRODUCT 
like any other copyrighted material, except that you may install the SOFTWARE PRODUCT 
on a computer for the uses permitted hereby. You may not copy the printed materials 
accompanying the SOFTWARE PRODUCT.   You may not loan, rent, lease, or otherwise 
transfer the other medium to another user, except as part of the permanent transfer (as 
provided above) of the SOFTWARE PRODUCT.

U.S. GOVERNMENT RESTRICTED RIGHTS. The SOFTWARE PRODUCT and 
documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure 
by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the 
Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or 
subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights 
at 48 CFR 52.227-19, as applicable.

MISCELLANEOUS

	 a.	 If you acquired this product in the United States, this EULA is governed by 	
		  the laws of the State of South Carolina.  In the event of any dispute arising 	
		  under this license or from the use of the SOFTWARE PRODUCT, each party 	
		  irrevocably agrees to the jurisdiction of the United States District Court for 	
		  the District of South Carolina, Charleston Division. 

	 b.	 If you acquired this product in Canada, this EULA is governed by the laws of 	
		  the Province of Ontario, Canada. In the event of any dispute arising under this 	
		  license or from the use of the SOFTWARE PRODUCT, each party irrevocably 	
		  agrees to the jurisdiction of the courts of the Province of Ontario and further 	
		  agrees to commence any litigation which may arise hereunder in the courts 	
		  located in the Judicial District of York, Province of Ontario. 

	 c.	 If this product was acquired outside the United States, then local law may 	
		  apply.
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LIMITED WARRANTY. Sawgrass warrants that (a) the SOFTWARE PRODUCT will 
perform substantially in accordance with the accompanying written materials for a period 
of thirty (30) days from the date of receipt, and (b) any Support Services provided by 
Sawgrass shall be substantially as described in applicable written materials provided to 
you by Sawgrass, and Sawgrass support engineers will make commercially reasonable 
efforts to solve any problem issues. Some states and jurisdictions do not allow limitations 
on duration of an implied warranty, so the above limitation may not apply to you. To the 
extent allowed by applicable law, implied warranties on the SOFTWARE PRODUCT, if 
any, are limited to thirty (30) days.

CUSTOMER REMEDIES. Sawgrass’ and its suppliers’ entire liability and your exclusive 
remedy shall be, at Sawgrass’ option, either (a) return of the price paid, if any, or (b) 
repair or replacement of the SOFTWARE PRODUCT that does not meet Sawgrass’ 
Limited Warranty and which is returned to Sawgrass with a copy of your receipt. This 
Limited Warranty is void if failure of the SOFTWARE PRODUCT has resulted from 
accident, abuse, or misapplication. Any replacement SOFTWARE PRODUCT will be 
warranted for the remainder of the original warranty period or thirty (30) days, whichever 
is longer. Outside the United States, neither these remedies nor any product support 
services offered by Sawgrass are available without proof of purchase from an authorized 
international source.

NO OTHER WARRANTIES. To the maximum extent permitted by applicable law, 
Sawgrass and its suppliers disclaim all other warranties and conditions, either express 
or implied, including, but not limited to, implied warranties of merchantability, fitness 
for a particular purpose, title, and non-infringement, with regard to the SOFTWARE 
PRODUCT, and the provision of or failure to provide Support Services.  This limited 
warranty gives you specific legal rights. You may have others, which vary from state/
jurisdiction to state/jurisdiction.

LIMITATION OF LIABILITY. To the maximum extent permitted by applicable law, in no 
event shall Sawgrass or its suppliers be liable for any special, incidental, indirect, or 
consequential damages whatsoever (including, without limitation, damages for loss 
of business profits, business interruption, loss of business information, or any other 
pecuniary loss) arising out of the use of or inability to use the SOFTWARE PRODUCT 
or the provision of or failure to provide Support Services, even if Sawgrass has been 
advised of the possibility of such damages. In any case, Sawgrass’ entire liability 
under any provision of this EULA shall be limited to U.S. $5.00. Because some states 
and jurisdictions do not allow the exclusion or limitation of liability, the above limitation 
may not apply to you.

ChromaBlast™ ink, ChromaBlast™ v1.5 media, ChromaBlast Driver™ v1.5, and 
Color Sure™ are trademarks, and ArTainium®UV+ is a registered trademark of 
Sawgrass Technologies, Inc.

General Notice: Other product names used herein are for identification purposes only 
and may be trademarks of their respective owners.  Sawgrass Technologies, Inc. 
disclaims any and all rights in those marks.
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Introduction
Congratulations on your purchase of the DualJet Hybrid Decorating System, featuring ArTainium UV+ 
and ChromaBlast digital transfer inks. The DualJet system, designed to work with the Epson Stylus 
PRO 4880, is the latest advancement from Sawgrass Technologies, a leader in the development of 
digitally-driven color transfer technologies and related products.

The DualJet Hybrid System for the Epson Stylus PRO 4880 includes ArTainium UV+ and ChromaBlast 
Inks, and the DualJet 4880 Driver. You will also need ChromaBlast transfer media to achieve soft, 
permanent digital images on cotton garments. This revolutionary system takes sublimation and cot-
ton decoration to the professional level, allowing users to create perfect transfers on a wide variety 
of substrates with minimal effort.

With the DualJet system, you can digitally decorate any polyester, poly-coated or light-colored cot-
ton product. Your imagination is the only limit for producing brilliant, photo quality images on caps, 
clipboards, clocks, mugs, mousepads, plaques, puzzles, synthetic or cotton T-shirts…and all point 
in between.

The DualJet 4880 Driver is user-friendly software that enables you to select your inset and control 
your color output. The DualJet 4880 Driver bundles sublimation color management software with the 
ChromaBlast print driver, giving you a powerful combination of customized decoration options. By 
using the DualJet 4880 Driver to print with ArTainium inks, your printed images can be transferred 
onto a wide variety of products designed to accept sublimation dyes, including: ceramics, metals, 
tiles, mylar, polyester fabrics, performance wear blanks and UniSub materials, resulting in a bright, 
vibrant, durable product. Using the driver interface to print with the ChromaBlast inks onto Chro-
maBlast media, your images transfer flawlessly to any white or light colored cotton product, such as 
t-shirts, grocery bags, caps…and more. The DualJet System for the Epson Stylus PRO 4880 is ideal 
for markets that specialize in short run personalized or customized products.
This document contains information for using ArTainium UV+ and ChromaBlast Digital Transfer Inks, as 
well as helpful tips for getting the best results from your transfers. The information provided pertains 
specifically to the use of ArTainium UV+ and ChromaBlast Digital Transfer Inks in your Epson Stylus 
PRO 4880 Printer, and is not meant as a substitute for the printer’s original operation manual.

NOTE: If you have questions about the operation of your EPSON Printer, refer to the EPSON Stylus 
PRO 4880 Printer User’s Guide. 

Technical Support is available from your Authorized DualJet Hybrid Decorating System reseller, or 
directly from Sawgrass Technologies, Inc. See the section entitled Technical Support on Page 62 for 
additional information.

Sawgrass Technologies strives to provide you with the tools to make the sublimation and cotton 
decorating process easy to learn and simple to master. We hope you will find that the tools we have 
developed will make your years in the sublimation and cotton decoration business fun and profitable. 
Please feel free to contact us with your feedback about or products. For additional information about 
our other products, please visit our website at www.sawgrassink.com. 

Thank you and enjoy your DualJet Hybrid Decorating System…
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Danger

Warning

Suggestion
/Remark

Tip

Indicates a Hazard that could 
seriously Compromise the 
use of the machine, and/
or the physical safety of the 
operator.

Indicates Must Do Items, 
significant warnings, and
Important Guidelines. These 
must be followed to prevent 
damage to your printer.

Indicates Suggestions to 
optimize the operation 
of your machine, or the 
printing process.

Indicates useful “Tips”, 
Materials, Practices, and/or
Observances that will have 
a beneficial impact on either 
Printing and/or Sublimation.

About this Document
This document contains descriptions and procedures for using ArTainium®UV+ and 
ChromaBlast™ Digital Transfer Inks, along with additional information for getting the 
best results from your transfers. 

The documentation provided pertains only to the use of ArTainium®UV+ and 
ChromaBlast™ Digital Transfer Inks in your EPSON Stylus PRO 4880 Ink Jet Printer.  
To assist you in the overall setup process, references are made back to the instructions 
contained in the EPSON Stylus PRO 4880 Quick Reference Printer Basics Guide.

	 To help point out important information, specific instructions, and 	
	 helpful tips, look for the following symbols:
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DualJet Hybrid System Ink Configuration

ArTainium® UV+ ChromaBlast™

Black

Cyan

magenta

Yellow

Black

Cyan

magenta

Yellow

When a cartridge is empty or low, INK LOW or REPLACE INK OUT will display 
on the LCD Panel. Raise, then lower the ink levers on either side of the printer. 
The ink indicator on the LCD Panel will flash, indicating which cartridge is 
low or empty. Be sure you have the correct color cartridge for replacement.

NOTE: The LCD Panel will indicate the ink colors 
of the original OEM Ink Configuration and not 
the DualJet Hybrid Ink Configuration.

1    2    3    4    5    6    7    8

Menu

3sec.

Do not install the Epson Inks provided with the printer. Please 
call Sawgrass Technical Support if you need assistance 
installing the ArTainium®UV+ and ChromaBlast™ Digital 
Transfer Ink Cartridges.

Installing ArTainium®UV+ and ChromaBlast™ Digital 
Transfer Ink Cartridges

If you are replacing existing cartridges because they are empty or low, please see the 
following instructions.  If not, go directly to Step 1, page 5.
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Figure 1 Figure 2

Figure 3 Figure 4

Figure 5 Figure 6

Installing ArTainium®UV+ and ChromaBlast™ Cartridges (Cont.)

1.	 Attach the power cord to the printer & plug the printer in to an appropriate outlet. 	
	 (Fig.1)  Ensure the printer power is on by pressing the power button on the control 	
	 panel. (Fig. 2)

2.	 Press the ink compartment cover to release the latch, (Fig. 3) and open the cover. 	
	 (Fig. 4)

3.	 Raise the ink lever to the unlocked position. (Fig. 5) The ink lever is located to the 	
	 right of each ink compartment. (Fig. 6) 
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Cartridge Configuration

Manufacturer

Channel

OEM

ArTainium UV+

ChromaBlast

1 2 3 4 5 6 7 8

Matte K C M Y Lt. K Lt. C Lt. M Lt.Lt. K

ArT K ArT C ArT M ArT Y

CB K CB C CB M CB Y

If you are just replacing an empty cartridge, then continue to step 4 
and 5 below.  If you are installing a full set of ArTainium®UV+ and 
ChromaBlast™ Digital Transfer Ink Cartridges, please continue to 
Step 6, Page 8.

 

Figure 8

Figure 7
5.	 Carefully remove its packaging and 
insert the replacement ink cartridge into 
the slot with the label side facing left. 
(See Fig. 8) Do not force the cartridge 
into the slot. 	Lower the ink lever in to 
the locked position. (Fig. 9, Page 8)

4.	 Remove the empty ink
	 cartridge from the printer.

Note: The cartridge label should be facing left as
	     the cartridge is inserted into it’s slot.

			   If you are installing a complete set of ink cartridges, then install using 	
			   the following order starting from left to right:

			   Left Side:
			   ArTainium UV+:	 Black (AT), Cyan (AT), Magenta (AT), Yellow (AT)
			   Right Side:
			   ChromaBlast:	 Black (CB), Cyan (CB), Magenta (CB), Yellow (CB)
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Figure 9

Figure 10 Figure 11

6.	 Lower the ink lever in to the locked position. 

7.	 Close the ink compartment cover if you have standard size ink cartridges installed.  	
	 (Fig. 10)  If you have extended cartridges installed in the printer, (Fig. 11), you will 	
	 need to leave the cover open.

8.	 After approximately 1 minute, the ink leer messages will appear on the LCD Panel. 	
	 The LCD will indicate that the printer recognized “NON-GENUINE” ink cartridges.



�
Sawgrass Technologies, Inc. ~ ArTainium®/ChromaBlast®DualJet™ Hybrid System 4880

8. Press the down key (V) until a message appears that asks the user whether the ink 
cartridges are “NON-GENUINE”.

9. Press the left key (<) to acknowledge that the cartridges are “NON-GENUINE”.

10. Press the left key (<) until the following message appears:
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11. Press the down key (V) until the following message appears:

12. Press the left key (<) to accept acknowledgement of the warranty message.

13. The following messages will appear:



11
Sawgrass Technologies, Inc. ~ ArTainium®/ChromaBlast®DualJet™ Hybrid System 4880

1    2    3    4    5    6    7    8

Menu

3sec.

Perform a nozzle check from The ChromaBlast 
4880 Driver™ Tab or the ArTainium 4880 Hybrid 
Driver Tab of the DualJet Driver.  A few cleanings 
may be necessary to get a good nozzle check.

14. Press the PAUSE key once.

15. The following message will appear. The printer is now ready for use.

16.	This completes your installation.
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SURFACE/SUBSTRATE Transfer Time
ArTainium UV+ TEMPERATURE P. S. I.

PRESSURE
REMARKS

CERAMIC 150-210 seconds 350oF-400oF 40 psi
Time varies with pressure. 

Use green tile mat for 
ceramic tile.

 
FR PLASTIC 75-80 seconds 400oF 40 psi Remove Plastic

METAL 
(Other) White, Silver, Gold 60 seconds 375oF- 400oF 40 psi

Time varies with manufacturer. 
(Contact reseller for times and temps.) 
Place absorbent sheet on bottom plate 

of heat press. Then place transfer 
paper, face up, on top of absorbent 
sheet. Next place substrate, face 

down, on top of transfer paper. For 
best results, remove paper from

 substrate immediately after setting.

METAL 
(Universal

Woods)
60 seconds 400oF 40 psi

Remove plastic.
Use absorbent sheet. 

MOUSE PADS 45 seconds 400oF 40 psi
POLYESTER FABRIC &

PERFORMANCE APPAREL 45 seconds 400oF 40 psi

SOFT L’INK™ 35 seconds 400oF 40 psi

Pre-Press for 5 seconds to 
eliminate moisture. Use Teflon 
sheet between sides of shirt to 

prevent “blow through”.

UNISUB™ PRODUCTS 75-85 seconds 400oF 40 psi Remove Plastic

Selecting Paper
Recommended Media For Best Results
For ArTainium UV+: 	 TruPix, TruPix Classic or TextPrint
For ChromaBlast:	 ChromaBlast Media
For further information on selecting the appropriate paper to use with your ArTainium®UV+ 
and ChromaBlast™ Digital Transfer Inks, please check our website at http://www.
sawgrassink.com/support or call your authorized ArTainium®UV+/ChromaBlast™ 
reseller. While the use of copy paper or other inkjet paper will not harm your printer, the 
transferred results may be light, splotchy, or uneven. Some papers may even stick to the 
surface or leave a visible residue.

ArTainium UV+ Heat Transfer (Sublimation) Instructions 
Because you can print on a variety of surfaces, you need to take all variables of the 
surface into account when selecting time, temperature, and pressure. Some of the 
variables are:

•	 Thickness of surface.
•	 Heat absorption; how fast the surface absorbs heat.

	 •	 Coatings used on materials to create a receptive surface for sublimation 	
		  inks. (Ceramics, Metals, Plastics, etc.)
	 •	 Accuracy of heat press unit. (Time, Temperature, and Pressure)
The specifics listed below are only guidelines. Due to the differences in heat presses and 
the various materials you will be printing on, it is not possible to give absolute figures. 
You should check with your supplier for specific heat transfer instructions or experiment 
to find your own preferred settings.  Practice makes money!
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ChromaBlast Printing and Heat Transfer Instructions
RECOMMENDED APPLICATIONS
White or light colored fabrics in 100% cotton.  

PRINTING
Print using the supplied ChromaBlast 4880 Driver program only.  The Print Side of 
ChromaBlast Media is opposite the ChromaBlast Logo.  For the Epson 4880 place Print 
Side face DOWN in the printer tray.  ChromaBlast Logo side UP.

Mirror Image:	 Check this box in the ChromaBlast Driver to ensure the image prints 	
	 in reverse and that text appears correctly when image is transferred.  	
	 If your image is already reversed in your graphic program, leave this 	
	 box unchecked.

TRANSFERRING THE IMAGE USING A COMMERCIAL HEAT PRESS
	 1.	 If desired, you may trim the non-printed area before transferring, leaving a .25 	
		  inch (1/4”) margin around the printed area.

	 2.	 Place garment on the heat press. Pre-Press for 3-5 seconds to remove 	
		  moisture.  Position a Teflon® sheet between garment layers to prevent “Blow 	
		  Through”.  Next apply ChromaBlast paper with reversed image face down, 	
		  against the garment surface to be printed.  Position carefully.

	 3.	 Press image according to the following recommended settings.
			   Pressure:	 Heavy	 If using a pneumatic press, set the pressure to 	
					     60 psi.
			   Temperature:	 375°F - 400°F (190°C - 205°C)
			   Time: 	 40 sec	 If you press the garment at a temperature 	
					     higher than 375°F, reduce the transfer time to 	
					     prevent scorching.

	 4.	 Peel the paper off immediately using an even motion.  
	 5.	 Stretch the image area lightly and evenly, while the shirt is hot, both side to 	
		  side and top to bottom to reduce the hand.

RECOMMENDED HEAT PRESS SETTINGS
Pressure:		  Heavy. If using a pneumatic press, set the pressure to 60 psi.

Temperature:	 375°F - 400°F (190°C - 205°C)

Time: 	 40 seconds. If you press the garment at a temperature higher than 	
	 375°F, reduce the transfer time to prevent scorching.

In order for the Media to bond the ChromaBlast Ink to the cotton fibers it is critical that 
the pressure and time relationship in the recommended settings above be maintained 
to achieve the best looking and longest lasting results possible.

STORAGE INSTRUCTIONS
Store ChromaBlast Media in a cool, dry area within the provided plastic storage bag.  Do 
not remove from carton until ready to use.
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User Guide
For the Epson Stylus® PRO 4880

For distribution with ArTainium UV+® and ChromaBlast™ 
ONLY 

NOT FOR RESALE

Ver. 1.0, Sept. 2008)
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Setup Instructions – Windows XP / Vista
The EPSON Stylus® PRO 4880 DualJet Hybrid System with ArTainium®UV+ and 
ChromaBlast™ digital transfer inks comes supplied with a single CD that includes both 
the ChromaBlast 4880 Driver™ and ArTainium 4880 Hybrid Driver™ Printer Drivers 
and documentation. The installation will autorun once the CD is placed in the computer. 
On-Screen instructions will prompt the user to register the software to facilitate full 
installation.

SYSTEM REQUIREMENTS
Minimum Hardware and Recommended Operating System:
Pentium 4 – 3.0GHz or Athlon XP 3000+ Processor
1 GB RAM  (2 GB recommended) Windows XP / Vista
30 GB of Free Hard Disk Space for Software and Processing Files
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Figure 1

Figure 2

Product Overview – DualJet 4880 Driver
DualJet 4880 Driver is a color management software solution that has been written as a 
windows printer driver.  It is designed to work with Epson ink-jet printers and Sawgrass 
sublimation ink.  The installation program will automatically install the Sawgrass Color 
Management Software, the Sawgrass DualJet 4880 Driver Printer Driver software, 
and ColorSure tools and utilities.

Step By Step Installation – DualJetDriver
	 1.	 DualJet 4880 Driver installation will now begin with the assurance that the 	
		  Epson Printer Driver Software is installed prior to this application.

	 2.	 The Welcome screen is displayed.  Click Next to proceed.  
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Figure 3

Figure 4                  

	 3.	 The License Agreement is displayed next.  Select the appropriate choice for 	
		  acceptance of the License Agreement to continue.

	 4.	 If you have not previously registered the DualJetDriver 4880, you will be
		  prompted to do so.  Registering is the only way to take full advantage of the
		  advanced features in DualJetDriver 4880.  If you choose to register later, 	
		  select Register Later and click Next to proceed with the installation.  (Fig. 0)
		  You will have five days to use the program before registration will be required
		  for continued usage of the software.  After five days, if you attempt to print
		  using the PowerDriverIQ software, you will be prompted to register.  (Fig. 0)	
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If you decide to register later, and continue using the driver 
during the initial five day pre-registration grace period, 
your system will generate the following Pop-Up Screen. 
Go to the printing preferences page of the DualJetDriver 
4880 driver and click on “Register.”

Figure 5

Figure 6

	 5.	 If you choose Register Now, fill in the radio button, (as shown in Fig. 6 below),
		  and click “Next”.
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Figure 7                  

	 7.	 In the DualJetDriver 4880 Registration Screen shown next, (Fig. 7), you will
		  use your Product ID (displayed at the bottom of Figure 7), to register and obtain
		  a Registration Code.  A Registration Code, (or Codes), may be had in any of
		  the following ways:	
			  a)		 Register on-line and receive your Registration Code via E-mail.
			  b)		 Call Sawgrass Technologies, Inc. directly (888) 253-1679 and obtain your 	
					    code over the Phone.
			  c)		 Send a fax and receive your Registration Code by Fax.  
		  You must have a separate Registration Code for every machine on which 	
		  DualJetDriver 4880 is installed.  The swiftest procedure by far is option a), by
		  E-mail, in which case, in Figure 7, click on the button labeled “Click here to 	
		  Obtain    Registration Code”.
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Figure 8                 

Figure 9                 

	 8.	 The Product Registration Web Page now opens.  Complete the requested 	
		  information on the web page and click Continue.

 

	 9.	 Once the website registration information has been completed, a “Thank You” 	
		  message will appear. 
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Figure 10                  

Figure 11                

	 10.	An e-mail has been sent to the address you specified.   Retrieve the registration
		  e-mail from your in-box and make note of the Registration Code given.  Toggle
		  back to the DualJet 4880 Driver Registration Screen, (Fig. 7, Page 24) and
		  enter this number in the “Registration Code” Box at the bottom of the DualJet
		  4880 Driver Registration Screen”, (Fig. 7), shown on Page 24.  Click “Apply 	
		  Code”.  Screen will appear indicating that you have successfully registered 	
		  your driver software.  Click “OK” to continue the installation process.

	 11.	Sawgrass Technologies, Inc. provides ColorSure color palettes for use with
		  Corel and Adobe.  (Check the ColorSure section of the manual for information
		  on how to use ColorSure to get perfect spot colors).  If Setup detects either of
		  these applications on your system, the palette files will be placed in the 		
		  appropriate folder indicated in the Destination Folder Box.  Click “Next” to
		  proceed with the installation.
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Note:	 In order to use PowerDriver as your Color Management Software,
	 the color management features in either Corel® or Adobe® Programs
	 must be disabled.  Please see the instructions in Appendix A, (Page
	 20), or click on the “Show Me How” Button on the “Color 		
	 Management Check” Screen shown in Item 12 below.

Figure 12

Figure 13

	 12.	The Color Management Check screen will appear. Click the “Continue” Button
		  on the left side of the screen after you have disabled the Color Management 	
		  feature of the Corel or Adobe Graphic software. Click “Show Me How” if you
		  need instructions on how to accomplish this.

	 13. With this Screen, Installation of the DualJet 4880 Driver will begin. Click 	
		  “Next” to continue.
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Note:	 Cancel any ‘Found New Hardware’ wizards that may start during this 	
	 process, do NOT cancel any file copy process however.

Figure 14                 

Figure 15

	 14.	The installation will continue for some time, depending on the characteristics 	
		  of your hardware.

	 15.	Once the installation has completed, the Hybrid  Installation Complete screen 	
		  will display.  Click “OK” to end the installation.
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DualJet 4880 Driver Introduction
DualJet digital printing systems are comprised of a few key tools to ensure high quality output 
each time you print with DualJet.  DualJet 4880 Driver color management software is one of 
those tools. 

DualJet 4880 Driver color management software is a professional grade color management 
program that provides SubliJet users with the necessary tools to ensure colors print right the 
first time.  DualJet 4880 Driver Software is available for all major Windows based operating 
systems.  
	
The DualJet 4880 Driver software and color profiles are simple easy-to-use color management tools 
to take the guesswork out of sublimation printing. With the click of your mouse, you can automatically 
optimize your output for popular substrates, such as Unisub, polyester performance apparel, ceramics, 
metals and many others. This is a valuable tool that saves you time, money and limit costs associated 
with proofing in an effort to get the color “just right”. The DualJet 4880 Driver also comes standard 
with the ColorSure Palette for managing the color output of your ChromaBlast cotton decorating 
inks. The ColorSure Palette includes more than 170 colors that, when loaded into your graphic 
design software, allows you to fill solid portions of artwork with a color from the palette. If you want 
to know how a particular color will look once transferred, simply print the ColorSure Palette onto 
the substrates you plan to work with. With the help of the ColorSure Palette, you will successfully 
choose the correct colors, whether you are matching colors for a custom order or selecting colors 
for new artwork. 

DualJet 4880 Driver is the most advanced color management software available on the market 
for digital transfer systems. This software was developed specifically for desktop sublimation 
systems; you will discover enhanced functionality as well as a new level of color output when 
DualJet 4880 Driver is used. Used in conjunction with digital transfer inks, you and your 
customers will truly experience the next generation in digital color!

Using DualJet 4880 Driver
DualJet 4880 Driver is simple to use. Whenever you have inks in your printer, you should print 
using DualJet 4880 Driver.  Do not print to your Epson printer with the Epson printer driver; 
printing with the Epson driver will not give you the benefit of color management.
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Figure 1                 

Figure 2

Note:	 Please see “Group 2 - Color Options” on 
page 35 for more in-depth information on 
color options available within the DualJet 
4880 Driver.

Quick Start Example (Corel Draw)

	 1)	 Open/Create an image in Corel Draw.  Select “Print” from the File Menu.    

	 2)	 Select the DualJet 4880 Driver.  Use the “Properties” Button (Fig. 2) to
		  access “DualJet 4880 Driver Properties”. (Fig. 3, Page 32)
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Figure 3

Figure 3 (a) Figure 3 (b)

	 3)	 In Figure 3 (a & b), you must set preferences according to the printing you 	
		  propose to do.  The “ChromaBlast 4880 Driver” is used only on cotton fabric. 
		  It cannot be used on a hard, non-porous surface, so the Substrate may decide
		  which ink you use.  You must also set the Size of image, Number of Copies, 
		  whether Bitmap or Vector, Print Quality, and Density.  Once this is done, click
		  “Apply” and then “OK” to return to the “Print” Window (Fig. 2).  Here, click
		  on “Apply”, and then “Print”.



27
Sawgrass Technologies, Inc. ~ ArTainium®/ChromaBlast®DualJet™ Hybrid System 4880

Figure 1

Figure 2
2

1

Setting DualJet 4880 Driver Document Properties
/Printing Preferences
To configure DualJet 4880 Driver for the correct substrate, you must 
display its Document Properties/Printing Preferences. There are two 
ways to display the Document Properties/Printing Preferences:

From the Windows Desktop:
1.	 Click on Start > Printers and Faxes.

2.	 Right-click on your DualJet 4880 Driver Printer. (Point 1) Scroll the Drop-Down 	
	 Menu and click on “Properties”. (Point 2) This leads to the  DualJet 4880 Driver
	 Properties Window. (Fig. 3, Page 32)
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Figure 3

Figure 4
Figure 4 (a) Figure 4 (b)

3.	 In the “DualJet 4880 Driver Properties” Window, click on the “Printing 		
	 Preferences” Button near the bottom of the screen in Fig. 3.  

4.	 You now have access to both the “ChromaBlast 4880 Driver”, & the “ArTainium
	 4880 Hybrid Driver” Windows, (Fig. 4, a & b), in the “DualJet 4880 Driver
	 Printing Preferences” Windows.
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Figure 1                  

Figure 2                  

From an Application:
1.    Select File > Print Setup.  Click to reveal “Print Setup”. (Fig. 2)

2.   Choose the DualJet 4880 Driver Printer from the list of printers.  Click the 		
	 Properties Button to access the DualJet 4880 Driver Document Properties.
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Figure 3                  

3.	 The DualJet 4880 Driver Document Properties Screen appears as shown. (Fig. 3) 

4.	 Select either the ChromaBlast 4880 Driver Tab, or the ArTainium 4880 Hybrid 	
	 Driver Tab, depending on the type of printing and substrate called for. (Fig. 3) 
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Figure 1                  

DualJet 4880 Driver Properties: (ChromaBlast)
The Figures below show the Document Properties/Printing Preferences for a 
registered version of DualJet 4880 Driver.
There are three main property groups (see the color-coded boxes in the screen shot, 
Fig. 1, Page 32, & Fig. 1, Page 39):

Group (1): 	Configuration  	Set Paper Size, Transfer Substrate, and Copy Count.
Group (2): 	Color Settings  	Color Management Control Options.
Group (3): 	Options  	Utilities for Printer Maintenance, Online Help, Product
				    Registration, and Setting Input Profiles.

NOTE	 There are two distinct drivers at work here.  They are: The “ChromaBlast
 		  4880 Driver”, & the “ArTainium 4880 Hybrid Driver”.  To facilitate clarity and 	
		  ease, we’ve color-coded the three groups so that similar functions across the 	
		  board, from one driver to the other, are identifiable, though they may not be 	
		  worded similarly or appear in the same relative location. 

	 ChromaBlast 4880 Driver Tab
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Figure 2                  

Figure 3                  

Figure 4                  

Group 1_Configuration: ChromaBlast 4880 Driver
Paper Size – From the drop down list, select the paper size you wish to use. (Fig. 2) 

Copies – Sets the copy count for the number of prints to be made.

To Add Custom Paper Sizes _ Click the + Button to the right of the paper size 
drop down list. (Fig. 3)

The following dialog box will appear. (Fig. 4) Insert the paper size and margins of the 
custom paper. (Fig. 5, Page 40) 
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Figure 5                  

Figure 6                  

Give the custom paper a name in the Form Name box.  (Fig. 5) Click on the “Add 
Form” Button when done.

Note that after adding a custom paper size, the printing preferences dialog box 
must be closed and reopened before the new paper size will show in the paper 
size drop down list. (Fig. 6)
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Figure 7

Figure 8                  

Deleting and Modifying Custom Paper Sizes
The driver uses standard “Windows Print Server” Forms for paper size definitions. 
These forms can be added, deleted, and maintained using the standard “Windows 
Print Server Properties” configuration dialog.  To access the Print Server Properties 
Dialog Box,  click on “Start > Printers and Faxes” from the Windows Desktop. 

From the “Printers and Faxes” Dialog Box, select File > Server Properties from the 
Drop Down Menu. (Fig. 8)
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Figure 9                   

In the “Print Server Properties” Dialog Box, click on the “Forms” Tab. (Fig. 8) From 
this Dialog Box, you can create and save a new form, or adjust and save or delete or 
rename an existing form.

Group 2_Color Settings: ChromaBlast 4880 Driver Tab

This tab gives you access to all of the color management controls available in ChromaBlast 
4880 Driver Tab.  Color correction allows you to create transfers from all kinds of images, 
from photorealistic images to spot color logos.  For maximum flexibility, ChromaBlast 
4880 Driver Tab lets you color correct bitmap and vector elements differently, even if 
they are in the same graphics file.  For example, if you scan a photograph and import it 
into CorelDraw, ChromaBlast 4880 Driver Tab will use the color management settings 
that have been selected for Bitmap.  If you then add text on top of the bitmap image, 
ChromaBlast 4880 Driver Tab will use the color management settings that have been 
selected for Vector.  The photograph and the text will be color corrected differently!  
Why?  You can now sublimate images with realistic photographic backgrounds that have 
vivid spot color text.  
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Vector and Bitmap Explanation
Bitmaps consist of a grid of pixels.  Bitmaps come from digital cameras, scanners, 
and photo CDs.  Bitmaps can also be created in applications like Corel PhotoPaint or 
Adobe PhotoShop.  Bitmaps have file extensions like GIF, JPG, BMP, and TIF.  Vector 
components consist of shapes, curves, lines, and text.  They are created in programs 
such as CorelDraw and Adobe Illustrator.  Higher end programs like CorelDraw can 
combine Vector and Bitmaps into a single image.  As a rule of thumb, if the object in 
your image is made of curves, text, shapes, or fills, it will be color corrected using the 
ChromaBlast 4880 Driver Tab settings.  All other image types will be color corrected 
based on the ChromaBlast 4880 Driver Tab Bitmap setting.

Bitmap & Vector Options
•	 No Color Management - All color management will be accomplished using the 	
	 Graphic Design Software.
•	 Graphics - This setting is most suitable for reproducing life-like
	 clipart.
•	 Photographic - This setting is most suitable for reproducing skin tones
	 in scanned photographs. 
•	 ColorSure Checkbox - ColorSure is used to replace specific colors in your image 	
	 with a spot color chosen from the ColorSure palette.  This resulting spot color
	 enhancement is not affected by color setting.  A ColorSure spot color will ALWAYS
	 print the same.
See Appendix C for an overview of ColorSure, Page 51.

ColorSure Options
•	 Print Palette Button – Prints the ChromaBlast ColorSure palette for the selected 	
	 substrate. ColorSure is a method for reproducing exact spot colors.  The two
	 main components are: 1) the Transferred Palette and 2) the CorelDraw, Corel 
	 PhotoPaint, and Adobe Swatches.  For a complete description on how to use
	 ChromaBlast ColorSure to get perfect spot colors, see Appendix C.
•	 Custom Palette Button – This button launches the Custom Palette Utility, which
	 enables you to add, edit, import, and export custom colors to the ColorSure 		
	 Palette.  If you need to precisely match a specific color, the Color Finder Tool 	
	 makes this a breeze.  For a complete description on how to use the Custom 		
	 Palette, see Appendix C.

Output Options
•	 High Speed – If the printer supports multiple resolutions, choose the most
	 appropriate setting.  For soft substrates, the High Speed option works well.
•	 High Quality – If the printer supports multiple resolutions, choose the most
	 appropriate setting.  For hard substrates, choose the High Quality option.
•	 Mirror – When you transfer an image, the result will be “flipped” when compared 	
	 to the printed image.  In order for your transfers to come out correctly, you must 	
	 flip the image before transferring.
•	 Max Density - Uncheck this box if you experience bleeding or smearing issues with 	
	 output.
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Group 3 – Printer Options: ChromaBlast 4880 Driver
•	 Utilities – Click this button to display a Utilities Screen.  From the Utilities 		
	 Screen you can print a Nozzle Check pattern, run a print head Cleaning Cycle,
	 align the printer’s Print Head, spool a DualJet 4880 Driver print file to the printer,
	 and print a page of primary ink colors.
•	 Help – This will display a help dialog box for an easy overview of the ChromaBlast 	
	 4880 Driver™  driver functions and settings.  Also contains a link to the Sawgrass
	 Technologies Website.
•	 Register – If the ChromaBlast 4880 Driver™ product has not been registered, 	
	 click this button for instructions on how to register the product and unlock all the
	 features.
•	 Input Profile – This option allows you to specify an input profile that the driver will
	 use when color correcting your image.  If you are printing scanned artwork and 	
	 your scanner manufacturer provided ICC profiles for your scanner model, select 	
	 the profile here   In order to select a profile IT MUST BE INSTALLED ON YOUR
	 MACHINE.  To install a profile on your machine, locate the profile on your machine
	 using Windows Explorer. (DualJet 4880 Driver supports both ICC and ICM profile
	 types).  Right click on the profile file name and select “Install”.

•Visit Project Sublimation – This button will take you to the Project Sublimation website.  
Are you looking for answers to your sublimation questions?  Would you like some hands-
on experience making products?  Do you want to learn more about color management?  
Project Sublimation tours cities throughout North America.  Check the calendar and sign 
up for an interactive Project Sublimation workshop in your area!



Sawgrass Technologies, Inc. ~ www.sawgrassink.com
38

Figure 1                  

DualJet 4880 Driver Properties: (ArTainium)
The Figures below show the Document Properties/Printing Preferences for a 
registered version of DualJet 4880 Driver.
There are three main property groups (see the color-coded boxes in the screen shot, 
Fig. 1, Page 32, & Fig. 1, Page 39):

Group (1): 	Configuration  	Set Paper Size, Transfer Substrate, and Copy Count.
Group (2): 	Color Settings  	Color Management Control Options.
Group (3): 	Options  	Utilities for Printer Maintenance, Online Help, Product
				    Registration, and Setting Input Profiles.

NOTE	 There are two distinct drivers at work here.  They are: The “ChromaBlast
 		  4880 Driver”, & the “ArTainium 4880 Hybrid Driver”.  To facilitate clarity and 	
		  ease, we’ve color-coded the three groups so that similar functions across the 	
		  board, from one driver to the other, are identifiable, though they may not be 	
		  worded similarly or appear in the same relative location. 

	 ArTainium 4880 Hybrid Driver Tab
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Figure 2

Group 1_Configuration: ArTainium 4880 Hybrid Driver

Paper Size – From the drop down list, select the paper size you wish to use. (Fig. 2) 

•	 Paper Source - Sets the Printer to choose the Paper in the Auto-Feeder, Roll Paper if 	
	 your unit is fitted with that option, or Paper that is fed manually into the printer.
•	 Copies – Sets the copy count for the number of prints to be made.
•	 Mirror Image - For work that has lettering, or a distinct “Right - Left” orientation, so 	
	 that when the image is actually printed on the surface and the paper sheet is removed, 	
	 the resulting image will read properly, from left to right.
•	 High Speed - If the printer supports multiple resolutions, choose the most
	 appropriate setting.  For soft substrates, the High Speed option works well.

Group 2_Color Settings: ArTainium 4880 Hybrid Driver

•	 360 x 720 - This resolution setting is for Soft Substrates such as garments, fabrics, 	
	 or mouse pads, etc.

•	 720 x 720 - This resolution is primarily for non-absorbent substrates or Hard
	 Substrates such as metal, plastic, ceramic, wood or Unisub®  type products.

•	 1440 x 720 - This resolution is for images that require the finest of detail.
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Group 3_Utility Options: ArTainium 4880 Hybrid Driver

•	 Nozzle check - This option allows you to be certain that all of your nozzles are clear 	
	 and 	functioning to prevent wasting ink.

•	 Clean - If the nozzles aren’t firing according to the patterns shown in the User’s 	
	 Manual provided by Epson, you now have the option of running a cleaning utility to 	
	 return the nozzles to optimum functionality prior to printing your images.

•	 Print Primary - Use this function to print a page of the Primary ArTainium Ink
	 Colors. (Cyan, Magenta, Yellow & Black)
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Setting ChromaBlast Driver™ 4880 Printer Properties
To configure this Driver for the correct substrate, you must display its printer properties. 
There are two ways to display the printer properties:

From the Windows Desktop: 
	 1.	 Click on Start > Printers & Faxes 
	 2.	 Right-click on your DualJet 4880 Driver™ Printer.
	 3.	 Select the “Printing Preferences” Button.
	 4.	 Select the “ChromaBlast 4880 Driver Tab.

From an Application:

	 1.	 Select File > Print Setup.
	 2.	 Choose the DualJet 4880 Driver™ Printer from the list of printers. 
	 3.	 Click the “Properties” Button. 
	 4.	 Select the “ChromaBlast 4880 Driver Tab. 

Setting ArTainium® 4880 Hybrid Driver Printer Properties
To configure this Driver for the correct substrate, you must display its printer properties. 
There are two ways to display the printer properties:

From the Windows Desktop: 
	 1.	 Click on Start > Printers & Faxes 
	 2.	 Right-click on your DualJet 4880 Driver™ Printer.
	 3.	 Select the “Printing Preferences” Button.
	 4.	 Select the “ArTainium® 4880 Hybrid Driver Tab.

From an Application:
	 1.	 Select File > Print Setup.
	 2.	 Choose the DualJet 4880 Driver™ Printer from the list of printers. 
	 3.	 Click the “Properties” Button. 
	 4.	 Select the “Printing Preferences” Button.	
	 5.	 Select the “ArTainium® 4880 Hybrid Driver Tab.
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Figure 1                 

Figure 2                  

Using ChromaBlast Driver™ 4880 in Windows XP/Vista
The ChromaBlast 4880 Driver™ is simple to use. Whenever you have ChromaBlast™ 
inks in your printer, you should print using the ChromaBlast 4880 Driver™.  Do not print 
to your Epson printer with the Epson printer driver; printing with the Epson driver will not 
give you the benefit of “Color Management”.

Quick Start Example (Corel Draw)
	 1.	 Open/Create an image in CorelDraw.  Select Print from the File Menu.

	 2.	 Select the DualJet 4880 Driver Printer from the Drop Down Menu, then click 	
		  on “Properties” to bring up the DualJet 4880 Driver Document Properties 	
		  Window.
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Figure 3                  

	 3.	 In the DualJet 4880 Driver Document Properties Window, choose the 	
		  ChromaBlast 4880 Driver™ Tab.  Here make your choices as to Print Size &
		  Quantity, Bitmap/Vector, High Speed/ High Quality, Density, Mirror, (so that
		  lettering or graphics with a left/right orientation will be legible after 		
		  sublimation),  and the ColorSure Option.  Once this is done, click “OK” to 	
		  return to “Print” Window.  Click “Apply”, then “Print”.
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Figure 1                 

Figure 2                  

Using ArTainium® 4880 Hybrid Driver in Windows XP/Vista
The ArTainium® 4880 Hybrid Driver Tab is simple to use. Whenever you have ArTainium® 
inks in your printer, you should print using the ArTainium® 4880 Hybrid Driver Tab.  Do 
not print to your Epson printer with the Epson printer driver; printing with the Epson 
driver will not give you the benefit of “Color Management”.

Quick Start Example (Corel Draw)
	 1.	 Open/Create an image in CorelDraw.  Select Print from the File Menu.

	 2.	 Select the DualJet 4880 Driver Printer from the Drop Down Menu, then click 	
		  on “Properties” to bring up the DualJet 4880 Driver Document Properties 	
		  Window.
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	 3.	 In the DualJet 4880 Driver Document Properties Window, choose the 	
		  ArTainium® 4880 Hybrid Driver Tab.  Here make your choices as to Print 	
		  Size & Print Quantity, Substrate, High Speed or Not, Mirror, (so that lettering 
		  or graphics with a left/right orientation will be legible after sublimation),  and
		  the Cutter Setting, if your machine is outfitted for cutting.  Once this is done, 	
		  click “OK” to return to “Print” Window.  Click “Apply”, then “Print”.
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Figure 1                  

Figure 2                  

Appendix A:
Over-Riding Design Software Color Management
The DualJet 4880 Driver provides a complete color management solution for your 
Hybrid ArTainium/ChromaBlast printing.  It is extremely important that you turn off any 
color matching features associated with your design software. An explanation of how to 
disable print-time color management in several popular design packages follows:

CorelDraw™ version 10, 11, 12, X-3, and X-4
•	 In CorelDRAW, open an existing, or create a new graphic.

•	 From the Main Menu choose Tools > Color Management. 
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•	 In the Color Management Window, set the Style option to Color Management Off.

CorelDraw™ version 9
•	 Create a new graphic.
•	 From the Main Menu choose Tools > Color Management. The Color Management 	
	 Dialog Box is displayed.
•	 In the Color Management Window (see figure below), UNCHECK the Calibrate 	
	 colors for display box.
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Adobe Photoshop CS3, CS2, CS, Photoshop 7 & 6:
	 Color Setup 
		  From the Main Menu, choose Edit, > Color Settings. In the Color Settings 	
		  Dialog Box, turn all Color Management Policies to “Off”. (See below.)  Mark
		  the box “Ask When Opening” next to “Profile Mismatches.

 

   

To Print; Adobe CS3:
Select File, > Print.  On the print dialog page, set the options as follows:
•	 Upper Right Hand Menu to “Color Management”
•	 Choose “Document” by clicking the radio button.
•	 Under “Color Handling”, choose “No Color Management”
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To Print; Adobe CS2, 
Always select File, > Print with Preview.  On the print dialog page, set the options as 
described in the following a thru d:
a.	 Click on “More Options”.

b.	 Choose Color Management in the drop-down menu.
c.	 Choose “Document” by clicking the radio button.“
d.	 Under “Options > Color Handling” choose “No Color Management”. 
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a
b
c

d

To Print; CS and Photoshop 7:
Always select File, > Print with Preview.  On the print dialog page, set the options as 
described in the following a thru d:
	 a.	 Click on “More Options”.
	 b.	 Choose Color Management in the drop-down menu.
	 c.	 Choose “Document” by clicking the radio button.
	 d.	 Choose Same as Source for Print Space.
From the Color Management drop option list, make sure that Source is set to 
“Document” and Print Space is set to “Same As Source”.
 

Adobe Photoshop Elements 5.0/4.0/3.0:
	 Select Edit and then Color Settings from the top drop down Menu Bar.  Select No 	
	 Color Management. Click Ok.
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To Print RGB Graphics
Click File, > Print, then set the 
Range, Print Quality, & Copies.

Fill in radio button “Document: 
Intagged RGB”.

In “Print Space”, “Profile” should 
read: “Same As Source”.

Press “OK”.

To Print CMYK Graphics
Click File, > Print, then set the 
Range, Print Quality, & Copies.

Fill in radio button “Document: 
Intagged CMYK”.

In “Print Space”, “Profile” should 
read: “Printer Color Management”.

Press “OK”.
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Appendix B:
Using ChromaBlast ColorSure™ and Custom Palette 
I.  Introduction
ColorSure is a method for reproducing exact spot colors.  There are four main 
components of the ColorSure System: 1) the Transferred Palette; 2) Color Finder; 3) 
Custom Palette; and 4) the CorelDRAW and Adobe application palettes / swatches.  

	 1.	 ColorSure Palette: This is your main color palette that includes a wide variety 	
		  of 190 commonly used colors.  
	 2.	 Color Finder:  If a color you need is not on the ColorSure Palette, the Color 	
		  Finder Tool allows you to locate the exact custom color you are looking for.
	 3.	 Custom Palette:  With the Custom Palette feature, you can add new custom 	
		  colors to the existing ColorSure Palette mentioned in Step 1.
	 4.	 Application Palettes:  You can add your Color Finder colors to an existing 	
		  application palette, or you can add multiple custom colors to new, custom 	
		  palette files (*.cpl, *.acl, etc.). 

II.  Printing the ColorSure Palette
			   The first step:	  Print and transfer your ColorSure Palette to the various 	
			   substrates you will be using.  Most likely you will have customers who
			   desire precise colors.  Having your ColorSure palette available allows the
			   customer to choose the color from the palette that is the closest match to
			   what they want, and this gives you a starting point for finding the exact
			   custom color that will match your customer’s needs. 

To print the ColorSure palette, follow the steps below:
	 •	 Click ‘Start’ and navigate to the ‘Printers and Faxes’ folder.  Right-click on
		  your DualJet 4880 Driver icon and select ‘Printing Preferences’ from the
		  menu. You may also open DualJet 4880 Driver from within an Adobe or Corel
		  program by going to File, Print, and choosing the DualJet 4880 Driver 	
		  printer from the pull-down menu.  Click “Properties” to open DualJet 4880
		  Driver. Select the ChromaBlast 4880 Driver Tab.
	 •	 Choose the paper size you will be printing the palette to (Letter, Legal, etc).
	 •	 Choose the substrate that you will be transferring the palette to.
	 •	 Select the speed / resolution of the palette – High Speed or High Quality.
	 •	 Be sure to check the box to mirror your print, click ‘Print Palette,’ and then 	
		  transfer the palette to the previously selected substrate.
	 •	 You now have a visual representation of how the ColorSure Palette colors will 	
		  appear on that particular substrate.
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1

2

III.  Designing Your Artwork

By picking colors from the ColorSure palette, you will be able to consistently reproduce 
colors in a reliable manner.  To assist you in designing your artwork, PowerDriver 4880 
and ChromaBlast 4880 install three palettes:  two for Adobe products and one for Corel 
products.  These colors match the palette that is printed from within PowerDriver and 
the ChromaBlast driver. 
 
	 •	 To open the ColorSure Palette in Corel 9, 10, 11, 12, X3, and X4, choose Window
		  > Color Palettes > Open Palette.  Select the file “ColorSure Palette
		  Corel.cpl”
	 •	 To open the ColorSure Palette in Adobe Illustrator, (Colorsure Palette.aco) 
		  choose Window > Swatch 	> Libraries > Other Library.  Navigate to its
		  Installation Destination set during PowerDriver  installation: C:\Program Files 
		  \Sawgrass \PowerDriver \Adobe Illustrator and hit Open. For easier access to 
		  the Palette File, copy it from this installation path to Illustrator10 \Presets \
		  Swatches and it will show up in your Drop-down list directly under the Swatch 
		  Libraries Menu. Other versions of Illustrator will have similar steps.
	 •	 To open the ColorSure Palette in Adobe PhotoShop, (Colorsure Palette.
		  aco) choose the “Swatches Palette”, click the option arrow on the palette, 
		  (Pointer 1), choose Replace Swatches, (Pointer 2), and pick the “Colorsure 
		  Palette.aco file.
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IV.  Using Color Finder
After printing and transferring the ColorSure Palette, you see that you have an array of 
colors to work with.  There will be times, however, when the color you need is not included 
in the ColorSure Palette.  This is where the Color Finder Tool comes in handy.  
The Color Finder Tool allows you to start with a specific color (e.g. navy blue) and find 
similar colors in the same family by adding and subtracting up to three colors called 
‘Step Colors.’  For example, starting with navy blue with a CMYK value of 60,60,0,40 
and choosing two step colors (e.g. cyan and magenta) would expand the original navy 
blue in four directions (more cyan, less cyan, more magenta, and less magenta).  This 
expanded color chart – specific to a particular substrate and printing speed – is outputted 
directly to your printer.

How to use Color Finder:
	 •	 Open the DualJet Driver Window as instructed in “Printing the ColorSure 	
		  Palette” outlined in Section II.
	 •	 First, make sure you select your desired Substrate, Output (High Speed or 	
		  High Quality), and the Mirror option from the Printing Preferences Window.  	
		  Click Apply at the bottom of the window.  This is a very important step as it 	
		  will 	affect the final printed output.
	 •	 At the bottom of the window, click the Custom Palette Button; this will open 	
		  the 	“Custom Palette Utility” Window.
	 •	 Click on Color Chooser and select your desired starting color from the matrix.   	
		  If you do not wish to use Color Chooser, you have the option to manually enter 	
		  the Start Color values in the CMYK boxes.

-	 To use Color Chooser, simply click on the ‘Color Chooser’ button in the top 		
	 right of the Custom Palette Utility Window.  You can then choose a color from the 
	 basic color selection, or you can click on the ‘Define Custom Colors’ button at the
	 bottom of the window.  This will display a color matrix.  To define a custom color, click 
	 any where in the matrix.  Use the slider at the right of the matrix to adjust luminosity.
	 Clicking ‘OK’ will automatically fill the CMYK boxes with the corresponding values.
-	 For advanced users, CMYK values can be determined by printing out a Custom 	
	 Palette, which is outlined in the next section. 

 
Custom Palette Utility
	 •	 You may alter the chosen color’s CMYK value by selecting two or three Step 	
		  Colors.  Using multiple step colors will present you with a greater range and 	
		  variety of colors to choose from.
	 •	 For instance, if you choose to modify your Start Color with two steps, then 	
		  Step Color 1 will change its values on the X (horizontal) axis and Step Color 2 	
		  will change its values on the Y (vertical) axis.  
 



55
Sawgrass Technologies, Inc. ~ ArTainium®/ChromaBlast®DualJet™ Hybrid System 4880

Color Finder Palette with two Step Colors
	 •	 If you modify your Start Color with three steps, Step Color 1 will remain the 	
		  same.  However Step Color 2 and Step Color 3 will form an imaginary ‘X’ and 	
		  their values will change on opposing diagonal Y axes.

Color Finder Palette with three Step Colors
	 •	 Next, determine what Step Size you want to apply to the Color Finder Palette.  	
		  This is simply a question of how much you want your Start Color to fluctuate.  
	 •	 If your Start Color is close the color you are looking for, use a low Step Size 	
		  (i.e. 	5-10).  However, if your start color is not close to what you are looking 	
		  for, 	use a higher Step Size.
	 •	 You can enter any Step Size value between 1 and 40.
	 •	 As an example, let’s say your Start Color is C:20, M:100, Y:150, K:0 and you 	
		  select Cyan and Magenta to be your Step Colors.  You also enter a Step Size 	
		  of 10.  When the ‘Print Colors’ Button is clicked,  your Start Color will be in 	
		  the middle of the Color Finder Palette and from there each color will vary the 	
		  Cyan and Magenta values by 10.
	 •	 When you are finished selecting the Start Color, Step Colors, and the Step 	
		  Size, click on the Print Colors Button.  This will print your custom Color 	
		  Finder Palette directly to your printer.
	 •	 After printing the Color Finder Palette, transfer it to your selected substrate 	
		  and 	then try to match your desired color to one that is on the palette.  If you 	
		  find 	a suitable match, you are finished using the Color Finder Tool.  Move on 	
		  to Section V. “The Custom Palette”. 
	 •	 If you couldn’t find an accurate match on the first printed Color Finder 		
		  Palette, don’t worry.  Follow the easy steps below, and you can find a more
		  suitable custom color.

To Find More Custom Colors
	 1.	 First, try to locate a new Start Color from the palette that is closer than the 	
		  original color.

	 2.	 Next, after finding a more suitable Start Color, write down that color’s CMYK 	
		  value.  Here is how to obtain this value.  There are numbers under each color 	
		  that are dependant upon which Step Colors you chose.  For example, it might 	
		  say C:70 M:120.  Take note of these values.  Then, at the bottom left of the 	
		  Color Finder Palette you will see a full set of CMYK values.  The new Start 	
		  Color’s CMYK value would be C:70, M:120 and whatever the Y&K values are 	
		  from the full set.

	 3.	 Lastly, plug the CMYK values for the new Start Color into the boxes in Color 	
		  Finder, choose your Step Size, and click on Print Colors once again.  
		  Continue with steps 1-3 until you find your desired color.
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V.  The ChromaBlast Custom Palette
Let us assume that you have found the exact color you need using the Color Finder Tool.  
What you will want to do next is apply these custom color values to either an existing 
palette, or to create a new custom palette altogether.  This allows you access to this color 
again should the same job arise.  

How to use Custom Palette:
	 •	 First, you need to assign the CMYK values of the matched color from the 	
		  Color Finder Palette to the Output Color CMYK fields in the Custom Palette
		  section.  
	 •	 Give your new custom color a descriptive Name in its designated field (e.g. 	
		  IBM Blue).
	 •	 Next, assign an “RGB Input Color” Value.  There are two methods to 
		  establish this value.

	 1.	 If you have the original file, sample the color that was matched in your graphic 	
		  design application with the eye dropper tool.  This will give you the RGB value 	
		  of that color.  Input this value into the RGB Input Color fields of the Custom 	
		  Palette Section.

	 2.	 If you do not have the original file, or the artwork has not yet been designed, 	
		  simply click on the ‘Input Color Chooser’ button, and then click on “Define 	
		  Custom Colors”.  From the color matrix, find a color that closely resembles 	
		  the color that you are adding to the custom palette.  At the bottom-right of the 	
		  color matrix window are the RGB values.  Simply click ‘OK’ and the RGB Input
		  Color values will be automatically entered.  Please take note of these RGB 	
		  values for later use in your design applications.
	 •	 Click the “Add Color” Button.  A window will pop up asking you whether you 	
		  want to add the color to the palette for all substrates, or just the current 	
		  substrate.  Click ‘YES’ here unless you have the same custom color saved on 	
		  palettes for other substrates.  Another window will then ask you if you want to 	
		  save the custom color for all resolutions or just the current one.  Click ‘YES’
		  here unless you have the same custom color saved on palettes for other 	
		  resolutions.
	 •	 Lastly, click the “Save Palette” Button.  When finished, simply Exit out of the 	
		  window.

					     The ‘Import Palette’ and ‘Export Palette’ Buttons are convenient
					     to have in the event you need to transfer palettes to and from 		
					     different computers.

VI.  Adding Swatches to your ChromaBlast Application Palette:
It is possible to add your custom color(s) swatch to an application palette as well.  You 
will need to take note of the Input Color RGB value that you assigned in the previous step 
in order to create the new swatch.  Refer to your specific design application software’s 
manual for instructions on this.
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        Tips for Successful Sublimation
 
POLYESTER FABRIC
Maintain appropriate heat press times
	 •	 Shortened pressing times will result in good surface color but the sublimation 	
		  dyes will not completely penetrate the polyester fibers. This leaves the dyes 	
		  more susceptible to wash out. 
	 •	 Longer pressing times will cause the dye molecules to penetrate deeper into 	
		  the fiber, creating a washed out look. For guidelines on transfer times, see the 	
		  section entitled Heat Transfer Instructions.
 		  Maintain appropriate heat press temperatures and pressure
	 •	 The correct temperature setting is vital for achieving desired results. Higher 	
		  temperatures can damage the polyester fibers to the point that they cannot 	
		  properly “hold” the dyes. For guidelines on transfer temperatures, see the 	
		  section entitled Heat Transfer Instructions.
	 •	 Too much pressure on the heat press may cause the dyes to penetrate too 	
		  deeply into the fabric causing a washed out look. For guidelines on transfer 	
		  pressure see the section entitled Heat Transfer Instructions.

METAL
To obtain the best results when printing onto metal, place the transfer between the metal 
and an absorbent cloth or fresh, non-textured paper towel. This will absorb any dyes that 
pass back through the paper and any moisture released during the transfer process. If 
you have problems with inconsistently filled areas, this may alleviate the problem.

CERAMIC TILES & MUGS
When transferring onto ceramic tiles and mugs, immediately peel the paper off of the 
ceramic after removing it from the heat press. Once the paper has been removed, cool 
the ceramic by submerging it in cool water, or run water over it from a faucet. If paper 
residue remains on the surface of the ceramic, clean with citrus cleaner. If you experience 
a significant paper-sticking problem, call your SubliJet reseller for assistance.

UNISUB
	 •	 Prepare the Substrate by peeling the transparent protective film off the 		
		  surface of the substrate (if applicable) and be sure you are working with a 	
		  clean, lint-free surface. To aid in the film removal process, touch laminated 	
		  edge of blank product to corner of heated platen on your heat press for about 	
		  5 seconds. Plastic will shrink, allowing you to peel away more easily and 	
		  reduce chipping the coating.
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	 •	 The starting dwell time for all UniSub products (metals, plastics, MDF) is 
		  60 seconds under 400 degrees F (200 degrees C) with medium pressure.
		  When doing bulk items in a single pressing, you may need to increase 		
		  overall dwell time 10-15 seconds to counter loss of heat. Transfer is arranged 	
		  image side down to blank, white surface (after removing protective laminate 	
		  film).  Consider taping transfer to back of product only as some products (e.g. 	
		  standard plaques) have foiled edges. Use only heat resistant tape.

	 •	 When storing or packaging finished sublimated products, do not stack 		
		  finished 	items, either when hot or cold, face-to-face. Do not wrap finished 	
		  pieces in shrink wrap or place them in a plastic bag for shipping.

	 •	 Visit www.unisub.com for additional information about sublimatible blanks 	
		  and 	for templates to assist you in selecting optimal sizes and materials.  

HANES SOFT L’INK SHIRTS
	 •	 The presence of moisture in your fabric can lead to bleeding of the image.  	
		  Remove moisture by pre-pressing your shirt for 10 seconds.  Use Teflon 	
		  sheets between the front and back of the shirt to prevent the inks from 		
		  penetrating to the other side of the shirt.  If dye residue from your heat press 	
		  is being deposited on your shirts at any time, heat press a paper towel or
		  similar absorbent material to remove it.
	 •	 Using a lint brush before pressing can greatly reduce lint or debris on the 	
		  shirt. 

MOISTURE & HUMIDITY PROBLEMS
The addition of moisture to the sublimation process can cause unwanted results. Under 
normal circumstances, the small amount of moisture that can accumulate in your paper 
is absorbed directly into the transfer substrate; however hard substrates like metal and 
ceramic are unable to absorb excess moisture. Some of problems that are attributed 
to moisture include: color shifting (colors lose accuracy), bleeding of the image, and 
uneven transfer of solid filled areas

To avoid these problems:
	 •	 Keep your paper in a dry place.
	 •	 If you suspect moisture, set the paper on your press for a few seconds. Do 	
		  not press it. Just expose it to the warmth. The heat radiating from the press 	
		  should help evaporate most of the moisture.
	 •	 To eliminate moisture in fabric, press the fabric for 10 seconds before doing 	
		  the 	heat transfer.
	 •	 Use an absorbent cloth or fresh, non-textured paper towel behind the transfer 	
		  sheet to absorb the moisture.
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 Supplies & Equipment 
Contact your authorized reseller to purchase sublimation supplies and equipment. For 
more information, see the Sublimation Supplies Directory on our website at www.
sawgrassink.com.

Operating Conditions
Certain environmental conditions should be taken into account for the operation of 
Artainium and ChromaBlast Inks, including temperature and relative humidity.

	 ArTainium UV+
	 •	 Supported operating Conditions are 65° – 80° F with 40 – 60% relative 		
		  humidity
	 •	 Optimum operating Conditions are 68° – 75° F with 40 – 60% relative 		
		  humidity

	 ChromaBlast
	 •	 Supported operating Conditions are 65° – 80° F with 35 – 60% relative 		
		  humidity
	 •	 Optimum operating Conditions are 70° – 75° F with 40 – 50% relative 		
		  humidity

Storage
	 •	 Care should be taken to prevent storing Artainium and ChromaBlast inks
		  below freezing temperatures (32°F, 0°C). Do not expose these inks to extreme 
		  heat (temperatures in excess of 104°F, 40°C). If these inks have been in storage,
		  you should allow them to reach room temperature before using them.  

	 •	 Do not expose Artainium or ChromaBlast cartridges directly to light, especially 	
		  sunlight, for extended periods. 

	 •	 For best results, install your Artainium and ChromaBlast cartridges by the 	
		  date on the cartridge.  Please refer to the individual ink bag/cartridge for the
		  specific ink expiration date.
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Troubleshooting
The troubleshooting tips found in this section relate mainly to problems that can be seen 
in transferred ArTainium and ChromaBlast images. If you are having problems related 
to the performance of your printer, please refer to the Problem Solving section found in 
the EPSON Stylus PRO 4880 Printer Quick Reference Guide.

The colors in my transferred image are incorrect
	 •	 The image may need color adjustment. Use the driver color matching 		
		  software.  For more information on how to use this software, please see the 	
		  relevant User Guide section above.
	 •	 Ensure you used the right printer driver and driver settings. Please see the 	
		  relevant User Guide section above.
	 •	 Ensure you pressed the item with the proper time, temperature, and pressure. 	
		  For guidelines see the section entitled Heat Transfer Instructions,
		  Page 12 & 13.
	 •	 Verify that all colors print correctly. Run the Nozzle Check utility and clean the 	
		  print heads as required.

My printout is really light on paper
	 Artainium ink naturally looks muted before the heat transferring of the image.  	
	 After transferring is complete, Artainium’s unique inks will produce a brilliant and 	
	 durable final product. 

My printout gets cut off on the bottom or side
	 •	 Verify the printer driver is setup for the correct paper size. Your printer driver 	
		  setting needs to match the paper size that is loaded in your printer.
	 •	 Ensure the right paper guide is in the proper position. When setting up the 	
		  printer, slide the right paper guide to the left until it clicks into position.

My image looks good but it washes out
	 •	 Ensure you pressed the garment with the proper time, temperature, and 	
		  pressure. If so, try pressing longer to ensure that the dyes are penetrating
		  the fibers sufficiently. For guidelines, see the section entitled Heat Transfer 	
		  Instructions.
	 •	 With ArTainium UV+, ensure you used a recommended paper. See the section 	
		  entitled Selecting Paper, Page . With ChromaBlast, ensure you used the 	
		  recommended ChromaBlast v1.5 Media and Inks.
	 •	 Ensure your substrate is designed to accept sublimation transfers. Garments 	
		  made from natural fibers, such as cotton, are not compatible with the 		
		  sublimation process.

Colors are light and splotchy
	 •	 Ensure you printed on the correct side of the paper or other media. With 	
		  paper, the print side is the bright white side.
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	 •	 Ensure you used a recommended paper (See section on Selecting Paper)
	 •	 Ensure you pressed the item with the proper time, temperature, and pressure. 	
		  For guidelines, see the section entitled Heat Transfer Instructions, Pages 12 	
		  & 13.
	 •	 Verify your printer driver settings are correct. Please see the relevant section 	
		  of the ArTainium 4880 Hybrid Driver or ChromaBlast Driver section of the 	
		  User’s Guide for  additional information.
	 •	 Ensure you do not have a moisture problem. For more information, see
		  the section entitled Moisture and Humidity on the Tips for Successful 		
		  Sublimation, Page 64.
	 •	 Ensure your substrate is designed to accept a sublimation transfer. 		
		  Garments made from natural fibers such as Cotton are compatible with 		
		  the ChromaBlast sublimation process.

My image looks blurred
	 •	 Ensure you pressed the item with the proper time, temperature, and pressure. 	
		  For guidelines, see the section entitled Heat Transfer Instructions, Pages 12 	
		  & 13.
	 •	 Ensure you used a recommended paper or other recommended media. For 	
		  more information, see the section entitled Selecting Paper.
	 •	 Ensure you printed on the correct side of the paper or other media. The print 	
		  side is the bright white side of the paper.
	 •	 Ensure you do not have a moisture problem. Try drying the paper on the press
		  or putting a paper towel behind the transfer when you heat press it. Read
		  the section entitled Moisture and Humidity in the Tips for Successful 		
		  Sublimation Section, Pages 56 & 57.
	 •	 Verify that the printer’s print heads are properly aligned. For further 		
		  instructions, see the EPSON Stylus PRO 4880 Printer Quick Reference 	
		  Guide.

My image has gaps or bands present
	 •	 Ensure that all of the printer’s nozzles are firing properly.  Perform a Nozzle 	
		  Check from the Utility Tab of your printer driver. For further instructions, see 	
		  the EPSON Stylus PRO 4880 Printer Quick Reference Guide.
	 •	 If one or more of the nozzles fail to print, perform a Print Head Cleaning. 	
		  For further instructions, see the EPSON Stylus PRO 4880 Printer Quick 	
		  Reference Guide.
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Technical Support
If you are having difficulties achieving good results from your ArTainium or 
ChromaBlast Inks, you have several support options:

1.	 Telephone: You may contact your authorized ArTainium or ChromaBlast reseller
	 during their normal hours of operation for assistance. A full listing of authorized 	
	 ArTainium and ChromaBlast Resellers is available on our Web Site at
	 www.sawgrassink.com. In addition, you may also contact Sawgrass Technical 	
	 Support at (888) 253-1679 between the hours of 8:30 AM and 5:30 PM Eastern 	
	 Standard Time. 

2.	 Internet: Visit the Technical Support area of the Sawgrass Technologies, 	
	 Inc. Web Site at www.sawgrassink.com.  The troubleshooting utility found here 	
	 will provide you with solutions to some of the most common problems.  You may 	
	 submit a detailed description of your problem if you need further assistance. 

3.	 E-mail: You may e-mail Sawgrass Technical Support with a detailed description 	
	 of your problem at support@sawgrassink.com. 

4.	 Fax: You may fax a detailed description of your problem to Sawgrass Technical 	
	 Support at (843) 849-3847.  


